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1 Interface Overview

Luxriot EVO Monitor is a dedicated application for viewing live and browsing the recorded contents of connected
Luxriot EVO servers. It also includes advanced features such as video and snapshot export, alert monitoring, PTZ
and digital PTZ control, among others. As Luxriot EVO Monitor is a unified interface for all Luxriot EVO editions,
some of the features described in this document may only be present if you are connected to Luxriot EVO Global
server and are not available for other server types (for example, the video wall feature).

For best user experience, display resolution of 1280x720 pixels or higher is recommended for Luxriot EVO
Monitor application, alongside with 512MB onboard video memory per display.

We recommend that end users and CCTV station operators become acquainted with this document in order to
understand the application interface and work out some personal usage strategies.

General

The Luxriot EVO Monitor interface is mostly intuitive. Elements are manipulated using left mouse button (click,
drag and drop) and mouse wheel (e.g., to change digits in timestamps). Right clicks (pop-up menus of all sorts)
have been eliminated to facilitate the Luxriot EVO Monitor application for usage with touch displays.

The application appearance can be changed to accommodate individual users' needs and preferences. Overlay
elements are adjusted in the Application settings, and component colours - using the Themes tool.

The main application functionalities are available via tabs. Visibility of these tabs and certain interface elements can
be controlled for each Luxriot EVO Monitor application instance using the Luxriot EVO Monitor Administration
Tool, which is available via main menu View -> Administration Tool.

Luxriot EVO Monitor interface

The Luxriot EVO Monitor application window title displays window name, display number, computer station name,
and also video wall title and display number.

Most elements (buttons, menu items, overlay elements) have tooltips - text hints that appear when you position the
mouse cursor over the item and hold it for a moment. Tooltips are enabled by default and can be turned OFF
via application settings.

Windows

The main (primary) application window displays contents provided by server or servers in different
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2 Interface Elements

This topic covers Luxriot EVO Monitor interface elements in more details.

Application elements and sections can be configured to be hidden via Luxriot EVO Monitor administration
tool. By default, all functionality is available based on the Luxriot EVO server configuration and license
limitations.

Main viewing area

The main viewing section displays contents provided by the connected servers. The type of the contents depends
upon the selected tab: this may be live video, several types of playback, data from external services etc. Please see the
corresponding sections of this document for detailed information about each mode.

Upper right corner: window controls

Standard window controls: go fullscreen, minimize, restore and close

From this panel, the Luxriot EVO Monitor application window can be:

opened in fullscreen mode
minimised to taskbar
maximised/restored to default size
closed

To toggle fullscreen , F11 can also be used. This is one of the default keyboard shortcuts: to change the action hotkey,
go to main menu Edit >> Command Mapping.

Upper panel: tabs

Luxriot EVO Monitor application upper panel with tabs

The upper panel contains tabs that allow you to quickly switch between main software functionality. The following
tabs may be available, depending on the software version and configuration:

Live: real-time video streams with PTZ controls, data overlay and instant playback
Playback: recorded video stream investigation
Sequence: advanced analysis of the recorded video streams
Smart Search: quickly find the target scene using motion search
Alerts: generated alerts and information level messages
Library: exported video clips and snapshots
Video Wall*: video wall display configuration
Reports: create diagrams and heatmaps based on the collected metadata
LPR**: investigation of the license plate recognition results
FR**: investigation of the face recognition results
Data Sources**: investigation of textual data received from configured external data providers

*The tab only appears when Luxriot EVO Global server connections are present, video walls exist in the Luxriot EVO
Global configuration and the used user account has sufficient privileges assigned via Luxriot EVO Console.

**The tab only appears if corresponding service is supported by Luxriot EVO license, the service has been set up via
Luxriot EVO Console and the used user account has sufficient privileges.

When all tabs do not fit in - either because of smaller screen size/resolution or due to decreased application window
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3 About

Information about the currently running Luxriot EVO Monitor software version can be viewed in following way: in
Luxriot EVO Monitor, go to the main menu, click Help and select About. This dialog box also contains links
to Luxriot website and technical support email for your convenience.

Important: Luxriot EVO server and Luxriot EVO Monitor application major versions must match. Example:
Luxriot EVO Monitor having version 1.3.0 will be unable to connect to servers having versions 1.2.0 or 1.4.0.

Maintenance versions within the same major version (e.g., 1.3.0 and 1.3.1) are compatible but we still
recommend that you match the software versions exactly for best performance.

Note that there is no information about the server license here as Luxriot EVO Monitor application can be connected
to several different servers at once. You can retrieve the server license details locally on each server.

Help -> About
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4 License Limitations

Please note that, as Luxriot EVO Monitor application is a unified interface for all Luxriot EVO editions, some
features described further in this document may not be available for certain Luxriot EVO server versions.

When the Luxriot EVO Monitor is connected to a server that is operating with a free license, the
following limitations apply:

each Luxriot EVO Monitor application can be connected to a single free server at a time
each free server can have no more than one simultaneous Luxriot EVO Monitor connection
some types of the resources will be not available (e.g., video walls, maps, user buttons, external services,
data sources)

 Some features, like video wall, will also be unavailable with Luxriot EVO S servers. Luxriot EVO Monitor
applications connected to Luxriot EVO Global server(s) will provide full functionality.
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5 Server Connections

The main purpose of the Luxriot EVO Monitor application is to display the contents of the local and/or remote
server(s). By default, Luxriot EVO Monitor contains a local server connection entry when it is installed together with
the server.

You can connect to multiple Luxriot EVO servers of different editions within the local network or over the Internet,
using built-in Luxriot EVO users or AD/LDAP domain users (pre-configured on the server side).  In the Luxriot EVO
Global system, you simply need to enter the central management server address, and all the Luxriot EVO Recording
Server and mirroring server connections are established automatically. If the Luxriot EVO Global server goes offline,
your Luxriot EVO Monitor application will be redirected automatically to the mirror, if it exists; if not, the Luxriot
EVO Recording Server connections will still be available (without enterprise features provided by Luxriot EVO
Global server).

In the Application settings, it is possible to set up automatic logout after a certain period of user inactivity. If this
setting is enabled, all the servers will be disconnected from if there is no user activity in the application interface;
default inactivity period is 15 (fifteen) minutes.

The Luxriot EVO software edition allows a maximum of 1 (one) simultaneous connection to the server; Luxriot
EVO Monitor can also only be connected to one Luxriot EVO server at once. Other software editions have no
limitations in this regard.

One concurrent connection to a server is maintained at a time to optimize the network traffic. For certain use
cases, you may want to create multiple connections to the same server with different credentials (having
different permission sets) without saving the passwords and ask each user to choose his profile and enter his
password when starting his session. To ensure that no person uses previous user's session, there is an auto
logout option after certain period of inactivity, which can be enabled in the application settings.

To connect to a remote server via local or public IP or hostname, follow the steps below.

Select the Connection section in the upper panel to bring up the dialog box.

Open the Connection section from the upper panel

Click the Remove button in the upper-right-hand corner to delete the existing (which, by default, is the local one)
server connection. Click the + Add server button to create a new server connection and fill the connection
parameters. Alternatively, choose Edit to adjust existing server connection settings.
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6 Application Settings

Luxriot EVO Monitor settings let you define the appearance and behaviour of the application, as well as pre-define
some defaults, such as video and snapshot export defaults.

Application settings are reachable via the main menu by clicking Edit -> Settings, and these cover all configurable
options of the program GUI. Note that parameters here are defined for the whole application and cannot be set
separately for application instances and/or individual layouts, channels etc.

General

General settings like the application language, automatic logout, exclusivity mode parameters etc. can be found here.

General section of application settings

The table below contains a detailed description for each setting.

Setting Description Default Value

Language Choose language for the application interface from the list of available
localizations (requires application restart); will affect both Luxriot EVO
Monitor and Luxriot EVO Console applications, if installed

Language set
during
installation,
English by default

Application
startup
mode

Enable the application to be started in the specified mode
(locked/exclusive/both/none); regular = no special mode

Regular

Interactive
user
idleness
action

Override or allow OS screensaver System Settings

Auto logout
after user
inactivity

If enabled, all the servers will be automatically disconnected after a certain
period of user idleness

Disabled

User
idleness
timeout

Time period in minutes, after which the auto logout will be executed 15 minutes

Exclusive
mode*

Defines if exclusivity mode is applied to all monitors or currently opened
application instances only

Opened screens
only

Exclusive User-defined password for unlocking exclusivity and locked application modes [none]
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7 Live View Section

Click the Live tab on the upper panel in order to switch to live video monitoring.

The panel on the left displays resources from connected servers: layout templates, layouts, channels, maps and user
buttons loaded from configured servers.

Search: global resource search
Layouts and layout templates

Local resources: stored on Luxriot EVO Monitor machine
Server resources: loaded from connected server(s)

Channels: per server or mixed, if the Merge resources option has been enabled in server connection
properties
Maps*
User Buttons*

*Some resources may be unavailable for certain software editions.

Depending on the resource type, you may be able to click and/or drag items. See the relevant sections of this manual
for detailed information on how to use and manage each of these resources.

Live view in Luxriot EVO Monitor

From the Layouts menu on the left, select your desired layout template and then drag and drop it into the
viewing area. Next, drag and drop channels from your desired server to the empty slots, using the Channels menu
section on the left. Layout templates can be selected either from default local templates or from server layout
templates. The latter can be created on the specified server via the Luxriot EVO Console management application.

You can save the current layout using the Save layout button in the upper-right-hand corner; it will become
available in the layout list on the left under the target server name. Right next to it, there is a button that can be used
to auto-detect displays, which is especially useful in multi-monitor systems.
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8 Multidisplay Setup

Click the Multidisplay setup  button in the upper-right-hand corner of the live view, next to the Save layout
button, to bring up the display selection menu.

Luxriot EVO Monitor automatically detects computer display configuration directly from Windows display settings:
click Identify to show the display numbers on all monitors - this will helpful if there is a large number of displays. To
change your multimonitor configuration, go to the Windows Control Panel -> Display -> Screen Resolution.

Multiple display selection

Luxriot EVO Monitor automatically detects which screen it is currently on: this display is marked blue and it is not
possible to create any child windows on it. Click on any other empty display (marked gray) to open a new live view
window there: the child window will be opened maximised, with the display number shown in the application
header. The controls in the upper-right-hand corner give the option to enter fullscreen or to close the extension
windows.

For the multiple display configuration, the following logic is applied:

the main Luxriot EVO Monitor application window acts as a parent window, in the sense that:
child windows for extension screens can be created and closed independently
when the main application window is closed, all other windows are closed as well

the main window can be located on any screen
only one application window can be opened per screen
child windows are maximized to fill all screen
child windows do not have menus or panels, just live view mode
double-click layouts and/or channels to load them in the main application window
drag and drop layouts and/or channels from the main window list to extension monitors

The advanced window settings dialog box offers the following possibilities:

create windows for the available displays and manage their properties
assign default layouts and sequences to windows (local displays only)
bind windows to video wall displays
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9 Keyboards & Joysticks

Luxriot EVO Monitor offers a set of keyboard shortcuts for most interface controls and operations, and also gives
you the option to re-program every single key combination, allowing you to assign your own key combinations to
every available operation (action). This is true not only for the standard computer keyboards, but also for PTZ
keyboards and joystick controllers.

The controller device should be DirectShow compatible in order to be recognized in Luxriot EVO Monitor.

All keyboards connected to the Luxriot EVO Monitor station are automatically detected and listed as available for
shortcut configuration; the list of default shortcut mappings is also attached automatically, if it is available for the
target controller. For PTZ keyboards, joystick functionality is not listed but it is implied that all joysticks have the
same behaviour, which includes pan and tilt on X and Y axes and zoom on Z axis. If you wish to calibrate your
joystick before using it in Luxriot EVO Monitor, please go to the Windows Control Panel and find your device under
Devices (Devices and Printers section).

The list of available commands is the same for each connected controller and cover most of the actions that
can be performed in Luxriot EVO Monitor. Commands cannot be added to the list manually at user's will but it
is likely that the list of the available programmable actions will be expanded based on the customer feedback.

In order to view and edit the shortcuts, go to the Luxriot EVO Monitor main menu -> Edit -> Command mapping.

List of mapped commands

From the Devices drop-down list, choose the keyboard you wish to configure the shortcuts for; if your device is not
in the list, make sure that it is connected to the server and that its driver has been installed correctly. Some devices,
such as standard keyboards, have an extended pre-configured (default) set of command shortcuts covering almost
all the available actions; generic ones have either no default configuration or shortcuts for calling first ten presets of
a PTZ-capable camera. 

In order to change shortcut mapping and replace it with your own key or key combination, simply double-click the
target command and enter your desired key combination from the keyboard. A minimum of one and a maximum of
four keys is expected for the standard keyboard, and a maximum of two keys - for PTZ keyboards or joysticks. If the
entered key or key combination is already used somewhere else, you will be prompted to either confirm the new
mapping or discard the changes and pick another shortcut.

Use the Load Defaults button in the bottom-left-hand corner if you wish to discard all changes for the currently
selected controller and load default configuration instead.

When you have finished with the shortcut configuration, click Save to confirm all changes and close the dialog box.
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10 Viewport Overlay

Each grid cell n live view can be thought of as a 'slot' - a rectangular part of the layout - and it is called a
viewport. Every viewport can accept channel video and maps, including geo maps.

In addition to the picture itself, every viewport contains detailed information about the video stream, as well as
several quick controls and toggle buttons, including PTZ controls. These elements overlay the video stream,
meaning that the actual video does not contain them and they only exist as a part or GUI for enhanced user
interaction.

The main overlay items are briefly explained below. Also, you will find some more details on some of the controls in
the Application settings and in the Video overlay sections.

Live View

Selected viewport with active  live stream

The following overlay controls are available in live view:

Upper-left: general viewport controls
X - close live stream and free viewport - available with or without viewport selection
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up
camera name
user buttons, if assigned

Upper-right: current time on the server from which the device originates
Lower-left: stream details

recording status: X = not recording, yellow arrow = recording
motion detector status: running = motion present, standing still = no motion detected
video codec of the stream
picture resolution, abbreviated
stream frame rate, FPS
stream bitrate, KBytes/s or MBytes/s

Lower-right: controls; enabled items are highlighted yellow
instant playback (not available if there are no recordings)
PTZ toggle: PTZ HUD and bottom panel ON/OFF
DPTZ toggle
motion grid ON/OFF
incoming audio ON/OFF (if enabled and supported by camera/software integration)
audio OUT: press and hold the microphone to speak (control is present only if the feature
supported by camera/software integration)
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11 Substreams

Substream is a lower resolution video used for reducing Luxriot EVO Monitor PC resource usage (CPU, network) for
live view display. Also, it is possible to play back secondary streams instead of high resolution video on low
bandwidth connections. For example: main stream for recording can be set to 1920x1080 at 30fps and substream -
to 640x480 at 15fps, which would provide much lower load for Luxriot EVO Monitor PC to display video stream.
This allows to have high quality recordings combined with the ability to view many video streams on a low-
performance Luxriot EVO Monitor PC and with limited bandwidth.

Both streams are available for live view and for recording (the latter is configured via Luxriot EVO Console). The live
stream selection is configured to Auto by default, which means automatic switching between higher/lower
resolution streams depending on the image size in order to save network and CPU resources. For instance, Luxriot
EVO Monitor may show a high-resolution stream if you view one camera at a time, but if you go to 4x4 view, Luxriot
EVO Monitor will automatically switch all the cameras to substreams, if they are available. In multi-channel views,
the application compares each viewport size to resolutions of both channel streams and decides, which one is better,
based on similarity to the output viewport size.

Luxriot EVO Monitor application has the following visual indication for substreams in live view as a viewport
overlay item (bottom right):

  Automatic selection between high and low resolution (based on viewport size)

  High quality picture

  Low quality picture (substream)

When no substream is available, the viewport overlay indicator simply will not appear at all for the target channel.

Substreams must be activated on your device via Web browser and, for some devices, this can be also done in the
stream properties in Luxriot EVO Console. Please verify camera performance to make sure substream can be
handled by the camera along with the other enabled features: some devices tend to drop the overall FPS with
the second stream turned ON.

Most cameras provide the second stream as a primary stream image scaled to fit the low resolution. However, some
devices crop the centre of a high-resolution image to fit the smaller frame, and thus the substream picture appears
as if it were zoomed in. Keep this in mind when you are using substream for live view and especially for software-
side motion detector analysis.

If both main and secondary streams are configured for recording, the target channel will be expandable in
playback mode and will have both tracks available for playback.

Substream footage in playback mode

Luxriot EVO Monitor User Guide

©2019 A&H Software House. All Rights Reserved.

32



12 Channels

All the channels from connected servers are listed in the Channels section of the Resources section on the left. If the
server connection has the Merge resources option ON, all resources will be shown together without per-server
grouping. Note that channels are displayed according to the logged user privileges.

Channels section

Channels are loaded with visual groups, if there are any; otherwise, they are simply listed under the relevant server
name. Use the Search filed above the channel list to quickly find a specific channel.

Double-click or drag and drop desired channels onto the layout viewports on the main live/playback window to view
stream contents. For secondary displays, use drag and drop method only.

When you double-click channels in live/playback view, they fill viewports in the following manner:

first, all the empty viewports are filled - from top to bottom, and from left to right;
then, the filling sequence starts again from the very first viewport.

To remove any channel from live view, click the overlay control X button next to the camera name in the upper-left-
hand corner of the viewport.
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13 PTZ

For PTZ-enabled cameras, pan, tilt and zoom controls are available both for live mode. Note that available controls
may depend on selected model and actual camera capabilities.

PTZ control is available in two flavours: HUD and classic PTZ sphere, with HUD enabled by default. Classic virtual
PTZ sphere controls can be turned ON via application settings as described below.

When two or more simultaneous PTZ command requests (either from an action or from direct user input) are
sent at the same time, PTZ priority parameter is used to decide who gains access first. When this happens,
request with a higher priority is fulfilled while request with a lower priority is delayed for ten seconds. If after
ten seconds the higher-priority action is still going on, the lower-priority action is denied PTZ access for ten
more seconds and so on.

If two users or actions with the same PTZ priority level have an access conflict, they will be both granted PTZ
access simultaneously and the order of executed PTZ commands is defined by which of the commands reaches
the device first.

Default PTZ priority for all users, including those built-in and imported, and also for all actions is equal to five
(medium priority). You can assign any user/action a higher PTZ priority (six to ten) or a lower one (four to
zero) by editing individual user/action properties in Luxriot EVO Console. The only exception is the PTZ
tours, which by default have the lowest priority (equal to zero), which means that any user or action can
intercept PTZ control; the tour will go on after the PTZ control from a higher-priority user/action is released.

PTZ control is carried out using the HUD overlay controls or point-to-PTZ style controlling without overlay
elements; it is automatically enabled if the camera has PTZ facilities.

If HUD or classic sphere is enabled, use the overlay PTZ sphere to control camera movement: click and
hold to move the camera up/down, left/right or diagonally; additional controls allow to adjust the
camera's iris and focus, as well as to zoom IN/OUT;
If visual PTZ controls are not enabled, click anywhere on the picture to re-position the camera using
indicated point as a new picture centre (point-to-click style).

When re-positioning a PTZ camera, note that some cameras may have response delay due to heavy device
load, physical distance, network latency etc. Bear this delay in mind when using PTZ and, if necessary, release
the virtual PTZ sphere controls earlier.

Switching Between PTZ Control Styles

By default, HUD style viewport overlay controls are used for PTZ. You can change this by going to the main menu
Edit -> Settings and choosing the Viewport overlays tab -> PTZ Controls section.
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14 Digital PTZ and Dewarp

Digital PTZ

Digital pan-tilt-zoom (DPTZ) can be enabled for both PTZ and non-PTZ cameras. This feature provides image
magnification by the means of cropping and enlarging the picture, additionally using the picture-in-picture feature
to display a preview of the whole stream when the original picture is zoomed IN. While it is mostly useful for devices
without optical zoom capabilities, if you do not wish to grant some of your users PTZ control access, then DPTZ can
be also used for PTZ devices. Also, digital zoom can be used for maps.

Last used digital PTZ position is preserved when you save a layout containing a zoomed stream or map.

In order to enable DPTZ in live view or playback, select the target viewport and enable digital zoom by clicking

DPTZ toggle  button on the overlay control panel in the bottom right corner. You can also set DPTZ controls to
be visible by default via Luxriot EVO Monitor main menu Edit -> Settings -> Viewport Overlays tab. 

Live view with DPTZ controls enabled

An additional panel with DPTZ controls will appear below the video stream. To use DPTZ with maps, simply use
your mouse wheel to zoom IN and OUT and then drag to view different parts of the map.
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15 Audio

Using Luxriot EVO Monitor application, you can listen to audio streams from cameras, play back recorded audio, as
well as talk back to the cameras. Recorded audio streams are also available when you export the recordings.

Two-way audio is also supported for the Luxriot EVO Mobile application; please refer to the mobile application user
guide.

In order audio stream to be available in Luxriot EVO Monitor, there are a few conditions:

the device, from which your selected channel originates, must be capable of sending/receiving audio
and this feature must be enabled and set to G.711 codec via device Web interface.
the device, from which your selected channel originates, must have audio support implemented in
Luxriot EVO; please contact Luxriot if you have doubts.
audio function must be enabled for the target channel via Luxriot EVO Console, please check the
settings via Luxriot EVO Console according to the Audio section of the Luxriot EVO administration
user guide.

Without these, audio IN/OUT controls will not be available for the selected channel.

Make sure that the speakers and the microphone on your workstation are properly installed and are operable
in order to be able to use the audio functionality in Luxriot EVO Monitor.

Live View

Audio IN/OUT toggle overlay controls are enabled by default for the live view and become available when you select
a viewport by clicking on it. You can change this preference via Luxriot EVO Monitor main menu by going to Edit ->
Settings: you will find the related settings in the Display controls section of the Viewport overlays tab. The available
display options are: always show the overlay control, show only if the viewport is selected and disable the overlay
control.

Audio overlay controls in Live view
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16 Motion Overlay

Click on your desired viewport and use the motion icon control in the bottom right corner to switch the motion grid
overlay ON and OFF. This will only work if motion detection is enabled for the selected channel.

Live view with motion overlay on a channel with software motion detector enabled

Apart from motion, other data may be overlaying the video, e.g., textual data and video analytics contents.
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17 Instant Playback

Interactive live view mode gives you the opportunity to browse the archive right in the same viewport,
without having to switch to the playback mode. This allows you to view recent footage for selected channels, while
still having live view displayed for other devices. By default, footage is loaded for the previous five minutes and the
playback starts five seconds before the current moment; use the <> timeline boundary controls to change time
range by clicking and dragging mouse to the right (zoom in) and to the left (zoom out) of the <> arrows.

This mode is only available for channels that have recording enabled.

To enable instant archive playback, use the Play button overlay control in the bottom right corner. The channel
will automatically switch to playback mode, allowing you to select timestamps, create bookmarks and export
snapshots/video clips. To exit instant playback mode, use X in the overlay controls' bottom right section.

Instant playback mode can be enabled for one, multiple or all viewports in the current layout: you can switch
between live and instant playback viewports without any limitations. This archive presentation mode is also used
when investigating data from external services and from data sources in the corresponding Luxriot EVO Monitor
tabs.

Instant playback mode
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18 Layouts

Layout is a pre-configured viewport configuration with channels assigned for live view and archive playback.
Layouts are created by filling a layout template with video channels. There are two main groups of layouts: local and
shared.

Local layouts are created and stored locally on the same computer where the Luxriot EVO Monitor is installed; these
are not available for other machines connected to the same server.

Shared, server-side layouts are kept on each server and are available for all users that are connected to the same
server from other client computers. If the license limits the client connection number to 1, layouts can still be shared
between non-concurrent client connections from different machines.

Layout template is a grid-like viewport pattern without any channels bound to it. There is a set of default layout
templates stored locally with each Luxriot EVO Monitor installation; also, user-defined custom templates can be
created via Luxriot EVO Console. Layout template with the channels assigned to viewports can be saved as a layout.

Layouts section

Drag and drop your desired layout template from the Resources menu on the left - either from the default local
templates or from pre-configured layout templates available under connected server. Template will be empty; drag
and drop channels from the relevant section of the menu on the left onto the layout viewports to fill the grid with
cameras. Channels' contents will be loaded automatically if it is available.

Click the layout menu  button in the upper-right-hand corner - just above the layout -  and select Save Layout
to save channel configuration as a new local or shared layout, or to overwrite any of the existing ones.
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19 Layout Sequences

Multiple layouts can be organized and saved as dynamic sequences, i.e. 'layout slideshows'.

To create a sequence, click the  button near Layout sequences in the resource explorer on the left.

Layout Sequences

The Create sequence dialog box will appear.

New layout sequence dialog box

Double-click layouts or drag and drop them to add/remove layouts to/from the sequence. For each layout, the
pause time can be specified separately, with the default layout duration being 15 seconds. You can add each layout
once or multiple times to appear in the sequence. If necessary, use the Search field in the upper-left-hand corner to
find a layout by name. It is possible to use both local and shared layouts.

Enter a name for the new sequence and then click Save. The sequence will appear in the resource explorer under
Layout sequences; drag and drop it onto the view area of any window or double-click the name to activate it for the
main application window. The sequence will then start automatically; sequence controls will appear above the
viewports, allowing you to switch between layouts manually and play/pause; also, the panel will also show the
remaining time for the layout that is currently displayed. If there is no connection to the server and shared layouts
cannot be loaded, the message on the panel will say "Retrieving layouts"; as soon as the connection is established,
the target layout(s) will be displayed.
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20 Maps

Maps and geo maps configured via Luxriot EVO Console can be viewed in Luxriot EVO Monitor: simply drag and
drop them from the resources list on the left to any viewport or use drag and drop to load them in the main
application window in live or playback mode. Maps fill the viewports just like channels but, unlike channels, they do
not have any footage or overlay controls. One map can be opened in one viewport or in many simultaneously.

Note that this resource type is not available for the free server license.

Map list in the Luxriot EVO Monitor

Maps inside viewports can be digitally zoomed IN and OUT with the mouse wheel and moved around using the left
mouse button (click and drag to move). Double-click inside any viewport with a map to switch to single camera view,
then click again to return to the layout view. Zoom level is preserved when you save the layout with the target map.

Map loaded in Luxriot EVO Monitor viewport

 All the cameras shown on a map can be loaded in Luxriot EVO Monitor with a simple double-click. In order to pop
up a channel from the map:

hover your mouse over the desired device on the map until it becomes highlighted with a pink circle
double-click the target device in order to map it automatically on the first non-locked viewport within the
current layout
change the viewport, drag and drop your desired channel by its title onto to viewport of your choice
if the device stream is already present on the layout, it will blink with a greenish yellow frame

User button markers placed on a map can be double-clicked to trigger the associated action. The marker will blink
indicating that the action is being executed.
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21 User Buttons

User buttons, as well as other types of resources from the connected servers, are available in the Resources panel on
the left. Note that this resource is not available for the free server license.

User buttons in Luxriot EVO Monitor

User buttons are created via Luxriot EVO Console; button behaviour is defined via Luxriot EVO Console using the
Event & Action Configurator.  There are three ways of using user buttons in Luxriot EVO Monitor:

double-click any button in the list of resources to make it trigger the action assigned to it
drag and drop any user button to a live view viewport to make the user button appear as an overlay control
for your desired camera, then click it once at any time to trigger the relevant action
double-click user button markers on the maps (markers are configured via Luxriot EVO Console)

User buttons cannot be added to the viewports that contain maps. Instead, go to the map management section in
Luxriot EVO Console and add user button markers to the desired maps to use them in Luxriot EVO Monitor.

Starting from the software version 1.4.0, multiple user buttons per viewport are allowed.

Starting from the software version 1.5.0, user buttons can be associated with one or more channels so that they
appear automatically in the viewport when live view of the related channel is shown. This can be set up via
Luxriot EVO Console, in the User Buttons section.

Each time a user button is pressed, the corresponding log entry appears in the Alerts section of Luxriot EVO
Monitor.

Alerts on user button pressing      
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22 Video Wall

Video wall configuration in Luxriot EVO is very flexible and it allows you to set up video output in virtually any
physical display combination. Templates for video walls are set up via Luxriot EVO Console and then they become
available in Luxriot EVO Monitor, depending on the permissions of the connected user. Using dedicated Video Wall
tab, you can easily control the contents of all available video walls.

Video Wall Setup

To access window setup in Luxriot EVO Monitor, open the Live section, click the Multidisplay setup  button in
the upper-right-hand corner - just under the main menu - and then click the Advanced button to bring up the
configuration dialog box.

Advanced window configuration

The advanced window settings dialog box offers the following possibilities:

create windows for the available displays and manage their properties
assign default layouts and sequences to windows (local displays only)
bind windows to video wall displays
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23 Playback (Archive) Mode

Select Playback tab to switch to archive playback mode. Your current layout will be used and recorded video streams
will be displayed for channels with enabled recording. If you wish to load footage from a different channel or
channels, or use a different layout or layout template, use the Resources panel on the left:

Layouts: double-click your desired layout to load it
Layout templates: double-click your desired layout template to load it, then double-click or drag and
drop the channels of your choice to fill the viewports
Channels:

double-click a channel to load it automatically within the current layout (first, empty viewports
are filled, then non-locked channels are replaced one by one)
drag and drop a channel onto any viewport to load it there

All channels will be listed under the servers from which they originate; or, if you have chosen to merge resources in
the connection properties, they will form an alphabetically sorted list. Each channel can be clicked and expanded in
order to access recordings of its main an/or secondary stream, as well as separate tracks recorded on failover
servers. When you double-click or drag and drop a channel by its title, all the tracks from its main stream will be
displayed automatically (e.g., tracks originating from different recording servers will be combined to form the
timeline).

All the footage having no associated active channels will be available under Orphan archive tracks. Such
recordings include footage from removed channels, renamed channels and also Luxriot VMS archive.

Luxriot EVO archive is protected with watermark. If archive contents has been modified with third-party
tools, a warning will be displayed during playback and a critical level entry will appear in the Alerts section.

Timeline and Playback Controls

Use the timeline and controls below to browse through recordings. For a multichannel layout, all channels will be
played synchronously.

Archive Playback mode

The following viewport overlay controls are available in the playback mode:

Upper left:
X - close the stream and free the viewport
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24 Sequence

The sequence explorer is an archive playback extension with additional tools for footage analysis. The whole
recorded stream can be split into smaller pieces down to 2 minutes in length; each of these can be played separately
or exported with a single click.

In the Luxriot EVO Monitor upper panel, click the Sequence tab: the current main window will then display the
sequence explorer with empty viewports.

Sequence explorer interface

Interface Overview

Interface elements have the following designations:

Calendar: specify the time period to be analysed by entering date/time boundaries, and also set the
viewport layout

date can be entered manually or selected from calendar view
time can be entered manually or adjusted by mouse wheel (select the value to be changed and
use mouse wheel to increase/decrease it, while keeping the mouse cursor over the field)
minimum time period is 120 seconds
available viewport layouts are: 3x4 (default), 3x5, 4x3, 4x6, 6x4, 5x5 screens

Top panel: <> arrows enable users to browse viewing history within the channel in use; the name of the
channel being used is displayed
Main window: displays video clip sequence with corresponding controls; empty viewports mean that no
footage is available for the time period selected
Bottom panel: contains global sequence controls for the whole currently displayed period (and not the
selected sequence elements) 

the << and >> arrows on the sides enable users to load the previous/next portion of the footage
sequence, with time period equal to the one set in the Calendar
next to the arrows, the date/time boundaries of the current video portion are shown
Play button in the centre of the panel will open current video portion in the Playback mode
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25 Smart Search

Along with regular archive playback and sequence exploring, Luxriot EVO Monitor application provides the smart
search feature, which allows you to specify a region of interest and let software search for motion events in the
defined area based on the existing motion detection (MD) metadata. This advanced search option is available for all
Luxriot EVO servers and editions.

There are two types of motion analysis operation: grid and area (frame). Grid type detection is
implemented for software-side motion analysis (both High Performance and High Accuracy modes), while
most devices send their motion detection metadata in the form of areas (frames), this is, the software only
knows if the motion was present in the configured zone, and exact location of the motion in that frame is not
available.

Understandably, precise results of smart search can be only obtained for grid-like detectors. Searching
through an area-type stream by motion region will give you motion events whenever motion has been detected
in the configured detection areas. In order to get better search results with device-side detectors, please adjust
the motion detection zone via device Web interface.

In order to start using smart search, click the corresponding tab on the upper panel of the main Luxriot EVO
Monitor window.

Smart Search option

When you open Smart Search for the first time since Luxriot EVO Monitor application startup, the main viewing
area will be empty. The resources menu on the left will contain all recorded streams, just like in regular playback:
simply drag and drop your desired video stream onto the viewing area in order to start working with it. The panel on
top of the viewing area will have your selected channel and stream name displayed then. The loaded stream will still
be there if you switch to some other tab and then go back to Smart Search.

Smart search with a loaded stream

Search Parameters

The search procedure consists of three main steps: define the region of interest, set the time period and
sensitivity, and analyse the results.
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26 Bookmarks

Luxriot EVO Monitor offers an opportunity to mark any specific moment in time so that it can be easily found in the
Playback mode later. It is possible to add bookmarks from live, instant playback, regular playback and smart search
modes; bookmarks are displayed and can be searched through in the regular playback mode.

The bookmark overlay control may be absent in the following cases:

your currently logged user does not have permissions to add bookmarks - in this case, the bookmark
control may be absent for specific channels only
the control had been hidden via application settings (by default, it is enabled)

Also, the bookmark button will be greyed out for orphaned archive tracks in the Playback mode (orphaned
tracks are recordings that have no active channel associated with them).

Add Bookmarks

Select your desired channel by clicking it in live, playback, instant playback or smart search mode.

Among the overlay controls in the bottom-right-hand corner of the channel, locate the bookmark icon  and
click it once. In playback mode, the New bookmark button is situated in the bottom-right-corner of the whole
viewing area, near snapshot and video export controls.
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27 VCA Events

Events from the server-side video contents analysis (VCA) engine, which are set to be recorded together with the
video stream, can be displayed in Luxriot EVO Monitor, investigated and also exported to an external file in the
comma-separated format.

VCA event data is available for server-side analytics and also for camera-side VCA in case metadata is
supported for that particular camera brand. For the exact manufacturer list with VCA metadata support,
please contact Luxriot representative.

In the regular playback and instant playback modes, VCA metadata is displayed as a thick white line over the
footage. This means these events can be searched for in the Playback mode. To access the VCA investigation panel,
go to playback mode in Luxriot EVO Monitor and click the VCA button in the top right corner.

VCA event investigation in the playback mode

The appeared panel will allow you to specify the search criteria, which are:

Source: a channel currently present in the layout that has VCA enabled
Search interval: time range to look for the events in
Search for: VCA item to search for, can be an object, a counter or an event

Object: all entries containing object appearance according to the VCA object classification
Counter: all moments where any counter value was changed
Event: all entries from triggered VCA rules

Class name: VCA class name (full or partial) according to the VCA internal object classification

When ready, press Search to get the results based on your refinements. Note that a maximum of 2500 events can be
listed at a time. Click any result in the list to jump to it in playback, then press the play button below the timeline to
start viewing the footage.

Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path.
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28 Reports

This section provides reporting functionality based on the previously collected data. There are two types of reports:
heatmaps, based on motion information, and charts, which use data from the software and VCA counters. You
can view the reports in the application and then export the results.

Heatmaps

Heatmap type reports represent motion density in the picture, thus highlighting the regions where the most
motion has happened during the selected time range. Heatmaps are generated based on the motion detector
(MD) data, therefore, motion detection must be enable beforehand for the target channel via Luxriot EVO Console
application.

Here are the requirements and some recommendations regarding heatmap reports:

target channel must have grid type MD enabled
motion information must be recorded with the video (represented by cyan colour on the timeline in
playback mode)
for PTZ cameras, make sure to select a static interval (during which the camera was not panned, tilted or
zoomed), otherwise the map will be inaccurate

Heatmaps use data from grid type motion detectors. Grid is guaranteed for software-side MD, and also for
a few device-side detectors. Heatmap detalization depends on the MD grid size: the smaller the grid cell, the
finer the map will be.

Most of the device-side MD do not support grid mode: if this type of MD is enabled in the device properties in
Luxriot EVO Console, you will get an "unsupported MD configuration" error and the heatmap will not be
generated.

To start, drag and drop a channel from the resources panel on the left. The channel name will appear on top of the
viewing area. If, for some reason, there is no motion data, or it is incompatible (frame type instead of grid), you will
get a corresponding error.

Next, select the target time interval, days and hours to be analysed:

Heatmap interval: defines the total report period
Filters: define the target range of time and exact days to be taken into account

For example, you can select one month as the time interval, and then only select weekdays (Mon-Fri), from 8AM to
8PM.

Use the Set time, +1h and -1h buttons below the channel preview to select the image to be used for the heatmap
overlay. Particularly, this makes sense for PTZ or zoom-only cameras, where the snapshot time matters. Also, you
might want to use this option to find a timestamp where lighting conditions are optimal, or there are no unwanted
objects in the scene. Use the Reset filters button below the settings in the right-hand panel to restore the default
filters (all days 24/7).

When ready, hit the Generate heatmap button: depending on the selected interval, this may take some time, and
you will see the generation progress displayed as percentage.
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29 Access Control

If your Luxriot EVO server employs a connection with a third-party access control system, it is possible to view
events and other data from the integrated module in the Luxriot EVO Monitor application.

Here is an example of how this can be done based on the connection to Doors .NET, which is possible thanks to the
integration of Luxriot EVO with Keri Systems.

Access Control

To start working with the access control data, switch to the Access Control tab in your Luxriot EVO Monitor
application.

Access control tab

There are three sections available here:

Events: the list of door events
Doors: door list with statuses
Cardholders: the list of cardholders

Click any event to view its details and associated recorded video (if a channel has been bound to the door in Luxriot
EVO Console). Events can be filtered based on time, door name, cardholder and/or event name (or a part of it).
Playback will appear on the right side as instant playback, with all usual controls, when an event is selected.

Click any door in the list to view its live status and associated live video (if configured). Every door will also have
three buttons to let you lock, unlock or temporarily unlock it. The View door events button will take you to the
Events section, with the event list filtered and only displaying entries related to the selected door for the last day.

In the Cardholders section, you will have the list of cardholders with pictures, if there are any. Use the Refresh
button in the bottom to reload the list. The View cardholder events button on the right will take you to the Events
section, similarly to door events: the event list will only display events for the target cardholder for the 24 hours.

Maps

Apart from the dedicated Access Control sections in Luxriot EVO Console and Luxriot EVO Monitor applications, it
is also possible to place door markers onto maps – either regular ones or geo maps. Markers on the map reflect door
open state and lock state. If such maps have been configured on the server, they will be available in the
corresponding section on the left, in the Resources panel.
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30 Video & Snapshot Export

Video clips, frame sequences, multichannel layouts and individual pictures can be exported in order to be viewed
later. without Luxriot software.

Snapshot Export

A snapshot of an individual channel can be taken at any time from live view, sequence explorer, instant playback and

regular playback modes. To save a snapshot, click the Snapshot  button in the overlay controls or bottom panel
controls.

In playback mode, it is possible to export a snapshot that will consist of all channels present in the current layout. To

do this, use the Multichannel Snapshot  button in the right side of the bottom panel.

The frames will be saved with your pre-defined frame export settings, if this option is enabled in the Application
settings; otherwise, you will be prompted to specify the file name and quality preference. After you have clicked the
snapshot or multichannel snapshot button, the frame will be automatically saved in JPG format and will appear in
the Library section of Luxriot EVO Monitor.

Video Export

Video export settings can be pre-defined in the Luxriot EVO Monitor Application settings. These include: file name,
output format, compression and resolution preferences, as well as subtitle settings. Some of the settings, when
selected, allow additional features like motion blur.

If you wish to embed the external textual data with the video or use motion blur, use MKV export format
with VP8 compression. MKV format also exclusively allows to export video in time lapse mode.

Time presentation settings do not affect video clip export. When you export a video clip from a remote server,
which is in a different time zone, and add timestamps in subtitles, your local time will be used.

You can choose to use the pre-defined settings always; otherwise, you will need to confirm or adjust the export
settings every time you export a video clip from anywhere. All the exported fragments will be displayed in
the Library immediately.

Video can be exported automatically (without additional time range prompt) by clicking the Video Export 
 button in the viewport overlay controls:

from Sequence Explorer, by selecting a range of at least two video fragments: selected clips will be
exported
from the Instant Playback mode: the most recent currently loaded footage will be exported at once (last 5
minutes, by default).
from the Smart Search mode, by selecting the desired search result: selected fragment will be exported

A video export dialog box with additional settings can be launched in the following ways:

from Playback mode, by clicking the Video Export button in the bottom right panel (the channel choice is
limited to those that are currently displayed plus multichannel export)
from Sequence mode, by clicking the Video Export button in the centre on the bottom panel (channel
choice is limited to channels currently being viewed)
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31 Alerts

The alerts section of Luxriot EVO Monitor features server notifications, e.g., logon/logout, camera events, as well as
miscellaneous errors that arise during operation: stream errors, server connectivity issues, device connection errors
and others. For example, if archive is corrupt or has been altered with third-party tools, a critical warning will
appear here.

Alerts section

 Use the Search field in the upper-right-hand corner to filter alert messages.

Alerts section with filtered messages

 Along with type and source, alert message and time are shown for each entry. If the message is too long to be
displayed in full, hover the mouse cursor over it to read full message text.
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34 Video Overlay

Channel Shortcuts

Channel shortcuts are interactive video overlay elements in live view, which allow you to switch to other (pre-
defined) channels. These can be thought of as "portals" to other channels. A simple usage scenario is to place
shortcuts on doors or street turns, so that users can track people as they move between the different camera views.

Shortcuts are configured in Luxriot EVO Console and then are visible in the Luxriot EVO Monitor application as
coloured rectangles overlaying the live video. Single clicking them will instantly display the linked resource
instead of the current channel. The shortcuts only work in live view and are invisible in other modes.

Street view camera with channel shortcuts

If the feature is not used, you can turn OFF the overlay visibility in the Luxriot EVO Monitor application settings:
this will disable the shortcut functionality. To do this, go to the Luxriot EVO Monitor main menu Edit  >Application
settings > Viewport overlays > Video overlays section and select the Always OFF option.

Text Overlay From Data Sources

If the connected server has data sources configured and these are associated with video channels, the received
textual data is displayed in Luxriot EVO Monitor application embedded with the video in the live view and in the
instant and regular archive playback, and it is also possible to search through the recorded text.

Live View

Textual data from the associated external data source will appear embedded with the live video stream. This
happens automatically and you do not have to do anything else in Luxriot EVO Monitor to enable the video overlay.
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36 Themes

Luxriot EVO Monitor colour scheme can be modified by changing the colours of individual elements and/or element
groups: buttons, date/time pickers, overlay controls etc. This functionality is available through Luxriot EVO Monitor
main menu Edit -> Theme.

Theme settings dialog box

All elements whose colour can be changed are grouped logically within the list and shortcuts to the groups are listed
on the left hand side.

Colour palette consists of three sections:

available colours: hues used in default Luxriot EVO Monitor looks
standard colours: pure hues with names (e.g., white, gray, purple etc.)
advanced settings: fully customized colour choice from RGBA (red, green, blue and alpha for
transparency) colour picker

All colours are coded in 8-digit hexadecimal RGBA notation; colours from the standard palette can be also referred
to using names, for example, black, white, red etc.

As you change the colours, they are immediately applied to the application theme. Once you have created the
desired colour arrangement, you have the following options:

Save as: save the theme settings into a XAML file
Save: save latest theme modifications and exit
Cancel: discard the latest changes and exit
Load defaults: discard all changes and reset the colours to Luxriot provided

Luxriot EVO Monitor User Guide

©2019 A&H Software House. All Rights Reserved.

99



37 Administration Tool

It is possible to customise Luxriot EVO Monitor looks by restricting certain functionality if users are not supposed to
see specific tabs, panels and/or menu items. This can be achieved by using the Luxriot EVO Monitor administration
tool, which is available via Windows Start Menu, under Luxriot EVO, or via Luxriot EVO Monitor application's main
menu View -> Administration Tool.

Windows Administrator rights may be required to launch this utility (UAC in action).

Every listed item is enabled by default and it is possible to hide it from the Luxriot EVO Monitor user(s). Note that
these settings are only applied to the Luxriot EVO Monitor application instance running on the local machine and
are not related to the user accounts used for server connection. In other words, for example, if you restrict access to
the Live tab, it will be hidden for both regular users and also the root administrative account(s).

Luxriot EVO Monitor administration tool

Currently, the tool offers the following functionality restrictions:

Visibility settings
Panes

Layouts: layouts, layout templates and layout sequences in the resources pane on the
left hand side, both local and server-side, for both live and playback modes
Channels: channel and channel visual groups in the resources panes in the left hand
side of live view
Channels (playback): channel and channel visual groups in the resources panes in
the left hand side of regular playback mode

Tabs
Live tab: live view section (all secondary windows will be removed as these are only
capable of live mode) including multidisplay setup and screen contents buttons
Playback tab: if disabled, regular playback mode tab will be hidden
Sequence Explorer tab: sequencing mode (advanced footage investigation)
Smart Search tab: search based on motion
Alerts tab: application notifications
Library tab: exported files (if disabled, users will still be able to export snapshots and
video clips)

Menu buttons
File: if disabled, corresponding main menu item will be hidden, preventing user from
using its contents
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